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MS Word Footnotes and Endnotes

Overview

Word enables you to use Footnotes, Endnotes, or both. You can also determine how they are
presented, up to a point. Word even enables you to specify the footnote and endnote separators,
continuation separators, and the continuation notice itself. Many publishers and publications are rather
specific about how to present Footnotes and Endnotes. Word’s flexibility usually helps you conform to
those varying specifications

Objectives

Participants will create Footnotes and Endnotes which are used to give credit to sources of any material
borrowed, summarized or paraphrased. They are intended to refer readers to the exact pages of the
works listed in the Works Cited, References, or Bibliography section.

Supplies: Basic un-styled document will be provided or you may bring in your own document. Optional:
Thirty minute lab time available immediately following 60 minute workshop.
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Microsoft Word 2007

“Microsoft Word is a word processor designed to make your work flow faster and easier and to make
you more productive,” says Microsoft. Knowing how to use MS Word effectively will make you more
efficient. This course is designed to help you make some tasks easier.

Creating a new document
Before we start creating Footnotes and Endnotes, let’s briefly talk about creating a new

document in MS Word 2007.

Click the Office Button located at the upper left corner.

6})

[% Home Insert Page Layout References

Office Button

. Click here to open, save, or print,
- and to see everything else you can
do with your document.

2

SEEQL

Ut —1 = ]

't_),l Press F1 for more help.

Use this Button to Save, Print, Prepare, Publish, Convert, and Create a New Document and Close.
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Click the Office Button and select New. A New Document dialog box will appear. You may select any of
the templates offered. Some of the templates are on your computer and some are templates offered
online.

Hew Document

Templates ~

_ Elank and recent l
Installed Templates Blank and recent

My templates...
Mew from existing... r 1 Q

Microsoft Office Online

Featured Elank document | MNew blog post

Agendas

Award certificates

Broachures

In the New Document dialog box Choose Blank and recent, New Blog Post, Installed Templates and etc.
If you would like to create a New Document using Templates, click one of the links, or type "brochure"

or "calendar," into the Search online for box, and then click Go. If you need HELP click on the
guestion mark icon and it will display help topics.

Choose the template you want.

If you have recently used a template or wizard, it will appear when Blank and recent are selected.
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You can also create your own templates to store styles, entries, and text that you plan to reuse often

and you will find those if you click My templates.
To create a New Document from an existing file:

e On the Office Button menu, click New.
e Inthe New Document under New, click New from existing.
e C(Click the document you want to create a new document from.

If you want to open a document that was saved in a different folder, locate and open the folder. Click

Create New from existing. This document is created in the folder that contains the original document.

The Ribbon in Word

Each program has a different Ribbon, but the elements on it are the same: tabs, groups, and commands.

There are three main parts to the Ribbon:

e Tabs sit across the top of the Ribbon. Each one represents an activity area.

e Groups are sets of related commands displayed together on tabs.

e Groups pull together all the commands you're likely to need for a type of task.

e Commands are arranged in groups. A command can be a button, a menu, or a box where you

enter information.

The Ribbon will adapt depending on what you're working on, to show you the commands you're likely to

need for that task. For example, if you're working with a chart in Excel,
the Ribbon will show the commands you need for working with charts.
Otherwise, those commands aren't visible.

Two more features that make the Ribbon programs easy to use are the
Microsoft Office Button and the Quick Access Toolbar.
-0 dV +
: You can modify the Quick Access Toolbar to meet
your own preferences.

The new Ribbon programs include two additional features that will
help you get your work done quickly and easily.

The Microsoft Office Button has replaced the File menu, and it's where
you'll find the same basic commands as before to open, save, and print
your documents — as well as for setting program options, editing file
properties, and more.

Customize Quick Access Toolbar

-

Mew

Open

Save

E-mail

Quick Print

Print Preview
Spelling & Grammar
Undao

Redo

Draw Table

More Commands...

Show Above the Ribbon

Minimize the Ribbon

The Quick Access Toolbar sits above the Ribbon and contains the commands that you want to keep near
at hand. By default, the Quick Access Toolbar contains the Save, Undo, and Repeat, (or Redo)
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commands, but you can customize it with whatever commands you want. Click on the little drop-down

-
|Estan1ize Quick Access Toolbar |

icon and you will see options you can include or remove. You may also

customize the way the Quick Access Toolbar functions.

Creating Footnotes and Endnotes
A footnote or an endnote consists of two linked parts — the note reference mark and the corresponding

note text. MS Word automatically numbers Footnotes and Endnotes for you, after you specify a
numbering scheme. You can use a single numbering scheme throughout a document, or you can use
different numbering schemes within each section in a document. If you add or delete or move notes
that are automatically numbered, word renumbers the footnote and endnote for you.

Note: If the Footnotes in your document are numbered incorrectly, your document may contain tracked
changes. Once you accept the tracked changes Word will correctly number the footnote and Endnotes

In Print Layout view, click where you want to insert the note reference mark.

On the References tab, in the Footnote group, click Insert Footnote or Insert Endnote.
Page Layout References

Ly Insert Endnote

ﬁg Mext Footnote =
Insert
Footnote

Footnotes [=

Change the Numbering
To make changes to the format of the Footnotes or Endnotes, click the Footnotes Dialog Box Launcher,

and do one of the following:
In the Number format box, click the format that you want.

To use a custom mark instead of a traditional number format, click Symbol next to Custom mark, and
then choose a mark from the available symbols.

e Click Insert
o Type the note text.
e Double-click the footnote or endnote number to return to the reference mark in the document.

The two major control centers for Footnotes and Endnotes are the Footnotes section of the References
Ribbon and the Footnote and Endnote Option Box.
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[ Footnote and Endnote |@—EE|1
Location
i@ Footnotes: Bottom of page Izl
(7 Endnotes: End of document
Format

[«]

Mumber format: 1, 2,3 ..

Custom mark: | | [ Symbal... ]
Start at: 1 =
Mumbering: Continuous |E|
Apply changes
. Apply changes to: | This section Izl

[ Insert J’ Cancel App

T ————————————

Short-Cuts to the Footnote and Endnote options are:
Alt+Ctrl+F — Insert Footnote
Alt+Ctrl+D — Insert Endnote

As for all Office shortcuts, if you forget, hover the mouse button over the Insert Footnote or Insert
Endnote option in the ribbon, it will remind you.

)
Insert Page Layout References Mailings Reviewr Viewr Developer
d Text = riyInsert Endnote = ) Manage Sources = £ Ins
date Table A—E‘: Mext Footnote - = tl% Style: APA - — =¥ Up
Insert Insert o Insert
Footnote E] Show MNotes Citation ~ ﬁjﬂlblmgraphy' Caption L[] Cre
tents Footnotes ] Citations & Bibliography Ca

|
Footnote and Endnote Options are as follows:
Footnote Location Bottom of page or Below text. Bottom of page puts the
Footnotes inside the bottom margin area, above any footer.
Below text puts them above the margin area at the end of
the text on the page where they occur.
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Endnotes Location End of document of End of section. Notes begin at the end
of the document or the section in which they occur,
immediately after the text, above the margin area.
Number format Endnote and Footnote number formats are independent of
one another. Both offer identical numbering formats (a, 2,
3/a, b, ¢/A, B/, ii, ii/1, I, Il and legal footnote symbols).
When specifying the legal symbols, they will double, triple,
etc., if the list of available marks is exhausted.

Custom mark Choose a custom mark to use for the footnote or endnote
symbol. You can specify only one. If you choose the ever-
popular *, you will get *, **, *** etc,, for the first, second,
third, etc., notes.

Start at Specify the number where you want footnote or endnote
numbering to start. This usually is used in conjunction with
the Apply Changes to This Section setting.

Numbering Can be continuous throughout the document, restarted
each section, or re-started each page.

Apply to Options are selected sections, this section, and whole
document.

Tip
To get back to where you were in the text when entering Footnotes or Endnotes, you usually can press
one of the GoBack keyboard shortcuts, Shift+F5 or click on the Footnote number.

To display the footnote and endnote; in Print Layout view, you will see the Footnote and Endnote like
this

SOOI IS T T R I LI

See how the footnote appears when you

hower owver the footnote or endnote

To edit the footnote or endnote:

In the References ribbon, click Show Notes. In Page Layout view, this provides access just to the notes
on the current page. In Draft view, this provides access to all notes, using the Notes pane.

In the text, double click on the reference mark for the note you want to edit. This opens the note or the
notes pane, depending on the current view.

Deleting Footnotes and Endnotes
Deleting Footnotes and Endnotes is easy, but confusing. We all want to go to the actual footnote or

endnote to delete it. Instead go to the reference number in the text and delete it or backspace and it
will remove the footnote or endnote text.
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Converting
You may convert all Footnotes to Endnotes or you can convert all Endnotes to Footnotes. The quickest
way is to switch to Draft view. Then, either click Show Notes in the References ribbon or double-click
any reference mark in the text. This displays the Endnotes or Footnotes pane. Use the droop-down
arrow at the top of the pane to select All Footnote or All Endnotes. You can also Press Ctrl+A to select
the entire contents of the current pane, right-click, and choose the Convert To option.

e Restarting footnote or endnote numbering

e On the References tab, click the Footnote & Endnote Dialog Box Launcher

e In the Start at box, click 1.

e Inthe Numbering box, click either Restart each section or Restart each page.
e Click Apply.

Creating a footnote or endnote Continuation Notice
Separators and Continuation

To change, set, or reset separators and continuation marks, you must be in Draft view. Go to the
References Ribbon in the Footnotes Group, click Show Notes. Using the drop-down arrow pick the item
you want to change.

If a footnote is too long to fit on a page, you can create a continuation notice to let readers know that a
footnote or endnote is continued on the next page. Make sure that you are in Draft view by click Draft
next to View on the status bar. On the References tab, in the Footnotes group, click Show Notes. If your
document contains both Footnotes and Endnotes, a message appears. Click View footnote area or View
endnote area, and then click OK. In the Note pane list, click Footnote Continuation Notice or Endnote
Continuation Notice. In the note pane, type the text that you want to use for the continuation notice.

Matter of Style
PLEASE, use the Footnote and Endnote style to format your Footnotes and Endnotes. These styles are
I Huee

Apply Styles G%D v X
Style Name:

Mormal El
[F‘.eapply ] [Modif’y... ]

AutoComplete style names

found at the same area where we find the normal paragraph
style options. To see the style dialog box type Ctrl+Shit+S. To modify this style verify that Footnote Text
or Endnote Text is displayed and click Modify. Change the style to your preferences. If you use this style
option and you need to change all the Footnotes and Endnotes styles later you can do it by coming back
here and modifying. Then one click will change the entire document’s Footnotes or Endnotes.
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